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1. INTRODUCTION
1-1 About the Data Analysis Software
Welcome to the Ambulatory Blood Pressure Monitor (ABPM) Data Analysis Software.
This software is intended for use with the following devices.

ABPM: For diagnosing high blood pressure

1) A&D TM-2430 Series Ambulatory Blood Pressure Monitor
2) A&D TM-2420/TM-2421 Ambulatory Blood Pressure Monitor            

and the TM-2020/TM-2021 Printer/Processor/Interface (hereafter referred to as "processor").

Home use monitor: For managing the blood pressure of a high blood pressure patient

3) A&D UA-767PC Digital Blood Pressure Monitor

The ABPM Data Analysis Software, that analyzes ambulatory blood pressure data, is a powerful tool
for diagnosing high blood pressure and managing the blood pressure of a high blood pressure
patient. The following features are incorporated in this software:

♦  Statistical Analysis Statistical data may be viewed in full, partial,
sleep, and awake intervals, respectively in full
screen, by switching between clearly labeled
tabs.

♦  Graphical Data Systolic/diastolic blood pressure, mean arterial
blood pressure, and pulse data are displayed
graphically to quickly determine patterns or
trends in the data.
Circadian rhythm and HBI analysis are
displayed graphically and numerically.

♦  Data Conversion The Data Convert feature automatically stores
blood pressure and pulse data in standard
(CSV) file format for use with popular
spreadsheet programs.

♦  Printed Reports Custom data report formats are easily defined
and printed.  “Mini-report” feature automatically
prints a compact summary report.

♦  On-line Help Built-in Help feature provides context-sensitive
help at any time.

♦  Maximum Time Period Doctor Pro can analyze up to one week’s data
starting from the oldest reading.
When used with the UA-767PC, Doctor Pro can
analyze up to five years’ data

♦  Maximum number of readings The maximum number of readings that Doctor
Pro can process is 900.
When used with the UA-767PC, Doctor Pro can
process 1827 readings.
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1-2 Symbols
The symbols printed on the device have the following meaning:

CE marking

SN Serial number

1-3 Monitoring Device Review
The following section briefly reviews the devices and how they may be used with this software.

A&D Ambulatory Blood Pressure Monitors are used to record an individual’s blood pressure over an extended

period of time, normally 24-72 hours. The monitor is worn by the patient.  The monitor non-invasively records

the patient’s systolic/diastolic blood pressure and heart rate based on predetermined intervals and conditions.

With a UA-767PC, the blood pressure data on individuals for a long period of time can be managed

and blood pressure trends are indicated clearly by using this software.

The user may divide each 24-hour period into several time intervals.  Within each period the monitor

may be programmed to record the patient’s blood pressure at 11, 31, 5, 10, 15, 201, 30, 60, and 1201-

minute intervals. The monitor can also be programmed to remain OFF during any time interval.

These measurement intervals may be timed to coincide with the patient’s daily activities.

The A&D TM-2020/TM-2021 Printer/Processor/Interface is used for performing one or more of the

following functions: Analyze blood pressure data stored in the monitor; program the monitor’s

intervals and conditions; function as an interface between the monitor and the software.

Note: Data that was initially analyzed using A&D TM-2020-01/02/03 or TM-2021-
01/02/03 Data Analysis Software Program for DOS™ is compatible with this
software’s format and can be analyzed by this software.

                                                  

1 The 1 and 3-minute measurement intervals are available only with the TM-2420/TM- 2421.

The 20-minute measurement interval is available only with the TM-2421.

The 120-minute measurement interval is available only with the TM-2421/ TM-2430.
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1-4 Software Package Components
Items included in your complete software package are:

♦  ABPM 3.5-inch program disk
♦  Ambulatory Blood Pressure Monitor Data Analysis Software Instruction Manual
♦  For TM-2420/TM-2421

AX-KO600 (9 pin D-SUB, socket type), Communication cable for TM-2420/TM-2421
♦  For TM-2430 series/UA-767PC

AX-KO1502 (9 pin D-SUB, socket type), Communication cable for TM-2430 series

1-5 System Requirements
♦  Computer A 486DX or higher microprocessor
♦  RAM Memory Minimum 16 MB
♦  Operating System Windows™ 95, 98, Me, 2000, NT 4.0
♦  Graphic Adapter SVGA video card

(minimum of 256 colors, 800X600 pixels or higher
recommended)

♦  Disk Type 3.5-inch floppy disk drive
♦  Hard Disk At least 2.5 MB
♦  Serial Ports Minimum one (9 pin D-SUB or 25 pin D-SUB)

(A cable separately available is required for the 25 pin
D-SUB serial port)

♦  Printer Type Printers supported by MS Windows™ operating system

1-6 Installing the Software
The software must be run from a hard disk drive only.  It may not be run from a floppy disk.  To

install the software on your hard disk drive, complete the following instructions:

Step 1 Insert the program disk in drive A:.

Step 2 Click the Start button on the Windows taskbar and select Run.

Step 3 Type “a:setup”

Step 4 Click OK.

Step 5 Follow the instructions on the screen.

Note The serial number is required when installing the software. The serial number is
printed on the label of the program disk.

1-7 Safety
Do not attach the monitor to a patient when the monitor, or the monitor and the processor, are being

connected to a computer.
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2. OPERATING PROCEDURE
2-1 Getting Started
Two initial actions may be executed when starting up the software:

(1)  Data may be retrieved from the monitor.

(2)  Stored data files may be opened and viewed for analysis.

  

To retrieve data from the monitor, see:

♦   “2-2 Communication Between the Monitor and the Software”

To view stored files, see:

♦   “2-5-1  Open”

2-2 Communication Between the Monitor and the Software
To communicate between the monitor and the software, the connection between the monitor and the

computer must be established first.

2-2-1 Connecting the TM-2420/TM-2421 to the computer

♦  You must use the A&D-supplied RS-232C communication cable, otherwise
communication errors will occur.

♦  Steps 1-4 must be completed prior to accessing the software or it may not recognize that
the monitor is connected to the computer.  If proper communication is not established, a

cable check error may occur.

♦  You must use AX-KO600 cable for 9 pin serial port (supplied) or AX-KO599 cable for 25
pin serial port (available separately as an option).

Figure 1: Connection between the TM-2420/2421 and the computer
(The illustration above is not to scale.)
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Step 1 Connect the monitor to the processor.

Step 2 Connect the male end of the A&D-supplied RS-232C communication cable to the
processor.

Step 3 Connect the female end of the A&D-supplied RS-232C communication cable to the
computer.

Step 4 The display on the processor will show “0-----”. If the processor does not have a
display, the LED should be green. If the LED is not green or the “0-----” does not

appear, see “3-2 Communication Errors”. If the processor shows “0-----”, go to step
5. If the processor has a green light, go to step 6.

Note: If possible, keep the cable connected to the computer unless the port is needed
for other functions.

Step 5 Press the ENTER key on the processor keypad. A series of 6 dashes “------” will
appear on the processor screen.

Step 6 Run the software.

Step 7 Confirm that the correct serial port is set. For details, see “2-9-4-2 Serial Port”.

2-2-2 Connecting the TM-2430 series to the computer
♦  You must use the A&D-supplied RS-232C communication cable, otherwise

communication errors will occur.

♦  You must use AX-KO1502 cable for 9 pin serial port (supplied) or AX-KO1503 cable for
25 pin serial port (available separately as an option).

Figure 2 : Connection between the TM-2430 series and the computer
(The illustration above is not to scale.)

Step 1 Connect the male end of the A&D-supplied RS-232C communication cable to the
monitor.

Step 2 Connect the female end of the A&D-supplied RS-232C communication cable to the
computer.
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Step 3 The display on the monitor will show “----”. If “----” does not appear, see “3-2
Communication Errors”.  Otherwise go to step 4.

Note: If possible, keep the cable connected to the computer unless the port is needed
for other functions.

Step 4 Run the software.

Step 5 Confirm that the correct serial port and the correct monitor type are set. For details,

see “2-9-4-2 Serial Port” and “2-9-4-3 Recorder Type”.

2-2-3 Connecting the UA-767PC to the computer
♦  You must use the A&D-supplied RS-232C communication cable, otherwise

communication errors will occur.

♦  You must use AX-KO1502 cable for 9 pin serial port (supplied) or AX-KO1503 cable for
25 pin serial port (available separately as an option).

Figure 3: Connection between the UA-767PC and the computer
(The illustration above is not to scale.)

Step 1 Connect the male end of the A&D-supplied RS-232C communication cable to the monitor.

Step 2 Connect the female end of the A&D-supplied RS-232C communication cable to the
computer.

Step 3 After the connection, the display on the monitor will not change. The display will show
“----”, just before starting communication.

Note: If possible, keep the cable connected to the computer unless the port is needed
for other functions.

Step 4 Run the software.

Step 5 Confirm that the correct serial port and the correct monitor type are set. For details,

see “2-9-4-2 Serial Port” and “2-9-4-3 Recorder Type”.

The software is now ready to:

♦  Retrieve data from the monitor. See “2-7-1 Retrieving Data from the Monitor”.
♦  Clear the monitor’s memory. See “2-7-2 Clearing the Monitor’s Memory”.

♦ Program the monitor’s intervals and conditions. See “2-7-3 Programming the Monitor’s
Intervals and Conditions”.
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2-3 Main Screen Description
The main screen is comprised of six menus and two toolbar buttons located permanently along the

top of the screen.  These menus may be used to access the various features of the software.  The

toolbar buttons may be used to set Partial Analysis and Blood Pressure Mode parameters.

Toolbar Buttons: (Only for TM-2420/TM-2421, TM-2430)

Button See Description
Analysis Intervals “2-4-1 Analysis Intervals” The Analysis Intervals button may be used

to define specific “Full” and “Partial” time
intervals within an opened data file for
custom data analysis.

Note: Not available with the UA-767PC.

BP Mode “2-4-2  BP Mode” The BP Mode selection box may be used
to specify which blood pressure
measurement method (Korotkoff,
oscillometric or both) is used as the basis
for statistical and graphical analysis.

Note: This only applies to TM-2421 data
files.

Main Menus:
  

Menu See Description
File “2-5 File Menu” The File menu may be used to manage the

files stored on the hard drive or a floppy disk
and to exit the software.

View “2-6 View Menu” The View menu may be used to access the
statistical, tabular, and graphical analysis
screens.

Recorder “2-7 Recorder Menu” The Recorder menu may be used to
program the monitor, clear measurement
data in the monitor’s memory and to retrieve
the measurement data from the monitor.

Report “2-8 Report Menu” The Report menu may be used to specify
report formats and print reports.

Option “2-9 Options Menu” The Options menu may be used to set the
default settings and user-defined
parameters.

Help “2-10 On-line Help” The Help menu may be used to view
information on software usage.  Help may
also be accessed by pressing F1 when
various screens are opened or by clicking
the Help button on a screen.
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2-4 Toolbar
There are two toolbar buttons which appear underneath the main menu bar:

(1) Analysis Intervals
(2) BP Mode

 

2-4-1 Analysis Intervals
The Analysis Intervals feature is used to define specific periods of time within an opened data file for

custom data analysis.  Two intervals, Full Analysis and Partial Analysis may be defined for each data

file.

Figure 4: Analysis Intervals dialog box

To set the Analysis Intervals, complete these steps:

Step 1 Click the Analysis Intervals button on the toolbar.

Step 2 Set each item in the Full analysis interval box, using the scroll bar.

Step 3 Check a Status button in the Partial analysis interval box. When “Enabled” is checked,
set each item in the box.

Step 4 Click the Save button.

Step 5 To cancel the settings, click the Cancel button.

The Partial Analysis Interval affects many of the software features including:

♦  Summary Data 
After the Partial Analysis Interval is enabled, the Partial tab in the Summary Data will be

activated.

♦  Trend Graphs 
After Partial Analysis Interval is defined, the data specified within the parameters will

appear in red on the Trend Graph.

♦  Correlation Plots 
After Partial Analysis parameters are defined, a second set of Correlation plots in red will

appear based on the data specified within the Partial Analysis parameters.
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♦  Histograms 
After Partial Analysis parameters are defined, the data specified within the parameters

will appear in red overlaying the Full Analysis data.

2-4-2 BP Mode
The BP Mode is used to select which blood pressure method will be used as the primary and

secondary choices for displaying the blood pressure measurement data. A&D monitors employ

either Korotkoff, oscillometric or dual Korotkoff and oscillometric measurement methods.  If the

current data file contains data from a dual system, you may choose Korotkoff, oscillometric or both

methods to analyze the data.

The measurement method(s) specified in the BP Mode will be the basis for the statistical and

graphical analysis performed on the opened data file.  The method noted with a one (1) is the

primary method and the method noted with a two (2) is the secondary method.  If a primary method

measurement error occurred during the monitoring session or a measurement is manually excluded

(see “2-6-2-1  Excluding/Including BP Measurements”), a valid measurement in the secondary
method will be substituted for it with the appropriate BP Mode selection.

Method Setting Description
Oscillometric only This option sets the primary blood pressure choice to

oscillometric and disables the secondary choice.  If the
oscillometric reading for any measurement is invalid or has
been excluded by the user in the BP Data List, the
measurement will be excluded from graphical displays and
statistical computations.

1: Oscillometric, 2: Korotkoff This option sets the primary blood pressure choice to
oscillometric and the secondary choice to Korotkoff.  If an
oscillometric reading is invalid, oscillometric readings will
be substituted with Korotkoff readings.  If both readings
are invalid for a measurement, all data from the
measurement is excluded.

Korotkoff only This option sets the primary blood pressure choice to
Korotkoff and disables the secondary choice.  If the
Korotkoff reading for any measurement is invalid or has
been excluded by the user in the BP Data List, the
measurement will be excluded from graphical displays and
statistical computations.

1: Korotkoff, 2: Oscillometric This option sets the primary blood pressure choice to
Korotkoff and the secondary choice to oscillometric.  If a
Korotkoff reading is invalid, Korotkoff readings will be
substituted with oscillometric readings.  If both readings
are invalid for a measurement, all data from the
measurement is excluded.



12

To specify the BP Mode while viewing an opened data file, complete these steps:

Step 1 Select the BP Mode box on the toolbar.

Step 2 Select the desired BP Mode used to view and analyze the opened data file.

Figure 5: BP Mode selection on toolbar

To set a default BP Mode for the software at startup, see “2-9-4 Default Settings”.

Note: The BP Mode for printed reports is assigned separately in the Report Format
Setup. See “2-8 Report Menu”.

2-5 File Menu
The File menu is used to manage the files stored on a hard drive or floppy disk.  It may also be used

to exit the software. The File menu has the following sub-menus:

Menu Description
Open This function is used to select a data file for viewing, modifying or

printing a report.  After a file has been opened, the file name, patient
name and date of the monitoring session are displayed in the title bar
of the main screen

Save As This function is used to copy a selected file to a new file with a
different name.

Delete This function is used to delete a selected file.

Convert This function is used to convert the blood pressure measurement
data of a data file to a format which is readable by most spreadsheet
applications.  The converted file will have the same name as the data
file with a .CSV file extension.

Merge the BP data files This function is used to merge multiple data files into one file.

Print This function is used to print reports for one or more data files
according to a user-selectable report format.

Exit This selection is used to exit the software.
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2-5-1 Open
The File | Open function is used to access the blood pressure data within existing data files.

Figure 6:  File Open dialog box

To open a file, complete the following steps:

Step 1 Select the File menu.

Step 2 Select the Open sub-menu.

Step 3 Select a file from the directory shown or move to a different directory.

Step 4 Click the Open button.

Note: The File | Save As, View and Report menus and Analysis Intervals buttons are
disabled until a data file is opened.

2-5-2 Save As
The File | Save As function is used to copy an open data file to another data file with a different
name or to a different directory with any name.

When a file is copied, corresponding .dat and .p files are created. These two files must stay together

within the same directory. The Save As function creates new .dat and .p file with the new file name

in the selected directory. When entering a new file name in the Save As dialog box, it is not

necessary to type the file extension. The original file will not be altered when using the Save As

function.

2-5-3 Delete
The File | Delete function is used to delete a data file.

CAUTION:  Data files will be permanently removed when deleted.
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2-5-4 Convert
The File | Convert function is used to create a .CSV (comma delimited) format file from a .dat file
that is compatible with most spreadsheet applications, including Microsoft Excel™. The .CSV file

that is created includes DATE, TIME, SYS, DIA, MAP, PUL headings so that the data can be

identified correctly when opened in a spreadsheet. The original file will not be modified in any way.

The data is being converted and will be saved to the same name and directory as the original data

file, but with a .CSV extension.

2-5-5 File Merge
The File | Merge function is used to merge multiple data files into a new file.

 

Figure 7:  File Merge dialog box

To merge multiple data files, complete the following steps:

Step 1 Select the File menu.

Step 2 Select the Merge the BP data files sub-menu.

Step 3 Select the data type to be merged.

Step 4 Open the folder that contains the data files to be merged.

Step 5 Drag the selected data files to the Merge-File-List Box.

Step 6 Click the OK button.

Step 7 Save the selected data files in a new file.

Note: •  The data files, of which time periods overlap, can not be merged.
•  The merged file will not open if the merged time period exceeds:

8 days (TM-2420/TM-2421 and TM-2430)
5 years (UA-767PC).

•  File merging is available only for data files of the same monitor. Data files of
different monitors can not be merged.
The default data type of the file merge dialog box, when opened, is UA-767P(C).
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2-5-6 Print
The File | Print function is used to print reports for one or more data files according to a user-
selected format. This enables the user to generate multiple reports without having to open each file

separately.

To print a report for multiple data files, complete the following steps:

Step 1 Select the File menu, then select the Print sub-menu.

Step 2 In the Print dialog box, select the files that you want to print a report for by holding
the Shift or Ctrl key down while clicking the desired files.

Step 3 Click Open.

Step 4 In the Report Selection dialog box, select the report format that you want to use for
the reports or click Print “Mini” report to print a condensed report. For “Mini” report
printout examples, see pages 60 and 61.

2-5-7 Exit
The File | Exit selection may be used to exit the software.

2-5-8 Saving a File
Files are automatically saved when the data is retrieved from the monitor. See “2-7-1  Retrieving
Data from the Monitor”.  Any modifications made to the data file are saved immediately when the
Save button is selected to close a function.

2-5-9 Closing a Data File
There is no file close feature in this software.  A file may be closed in two ways:

1) By opening another file.  The current file will automatically be closed when you open

another file.

2) By exiting the software.
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2-6 View Menu
The View menu may be used to view numerical, statistical and graphical data screens. The View

menu is disabled unless a file is opened.  For information on how to open a file, see “2-5-1 Open”.

The View menu has the following sub-menus:

Menu See Description
Summary Data “2-6-1 Summary Data” Function for viewing statistical data.

BP Data List “2-6-2 BP Data List” Function for viewing numerical data and
entering comments.

Trends “2-6-3 Trends Screen” Function for viewing blood pressure, mean
arterial blood pressure, pulse (heart rate) and
double product trends.

Correlation “2-6-4 Correlation Plots” Function for viewing correlation plots of
systolic blood pressure to diastolic blood
pressure and diastolic blood pressure to
pulse.

The scatter diagram allows easy observation
of the correlation between systolic and
diastolic blood pressures; the minimum and
maximum values, the magnitude of fluctuation
and the density, of a 24-hour blood pressure
data.

Histograms “2-6-5 Histograms” Function for viewing the frequency distribution
of the measurement data.

Allows easy observation of the data that
occurs most frequently, the frequency
distribution and the distribution width during
the time interval.

Circadian rhythm “2-6-6 Circadian Rhythm” Function for viewing the graph showing the
estimated amplitude and peak position, and
the numerical data, based on the 95%
confidence interval and the cosinor analysis
graph.

Note: Not available with the UA-767PC.

HBI analysis “2-6-7 HBI Analysis” Function for viewing the graph showing the
hyperbalic area and hypobalic area, and the
numerical data converted into a one-day
period.

Hyperbalic; that area exceeding the user-
defined limits for the sleep and awake
intervals.

Hypobalic; that area not reaching the user-
defined limits for the sleep and awake intervals.

Note: Not available with the UA-767PC.

Patient Information “2-6-8 Patient Information” Function for entering patient and physician
information, as well as fields for the sleep and
awake intervals.
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2-6-1 Summary Data
The Summary Data screen includes statistics on the data of the opened file and may be viewed

directly on the screen. These statistics are separated into four data tabs:

Full Statistics based on all the data within the file.

Partial Statistics based on the data specified in the Partial Analysis parameter. See “2-4-1
Analysis Intervals”.

Awake Statistics based on the data during the waking hours.

Note: Waking hours are specified as those hours outside the identified sleeping hours.

Sleep Statistics based on the data during the specified sleeping hours. See “2-6-8  Patient
Information”.

To view, close, or print the individual Summary Data screen, complete the following steps:

Step 1 Select the View menu.

Step 2 Select the Summary Data sub-menu. The Summary Data display appears.

Figure 8: Summary Data display

Step 3 Click one of the four data tabs, Full, Partial, Awake or Sleep.  The Full tab will always
be enabled. The Partial, Sleep and Awake tabs will be enabled after they are

specified.  See “2-4-1 Analysis Intervals” to specify Partial Analysis and “2-6-8
Patient Information” to specify the Sleep interval.

Step 4 To print the data for an individual Summary Data tab, select the tab you want to print

and click the Print button on the right hand side of the screen.

Note: You may also print the Summary Data screens in the standard report, see “2-8
Report Menu”.

Step 5 Click the Close button to close the Data Summary screen.
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Each of the four Summary Data is titled with the name of the tab, file, patient and measurement

method.  For detailed information on Summary Data screen listings, see below:

Summary Data Tab Definition
Time Interval The analysis period, start time/date – end time/date, for the

activated Summary Data tab.

Valid Readings The total number of measurements taken during the monitoring
session less any monitoring errors or manually excluded readings
within the data set. See “3-1  Measurement Errors” for
information on measurement errors.

Excluded Readings The measurement error percentage. This figure is based on the
combined total of measurement errors and excluded
measurements.

Min (Minimum) The minimum measurement value for Systolic, Diastolic, MAP
and Pulse measurements during the Time Interval.

Mean The mean value for Systolic, Diastolic, MAP and Pulse
measurements during the Time Interval.

Max (Maximum) The maximum measurement value for Systolic, Diastolic, MAP
and Pulse measurements during the Time Interval.

SD (Standard Deviation) The Standard Deviation of the value for Systolic, Diastolic, MAP
and Pulse measurements during the Time Interval.

SE (Standard Error) The Standard Error of the value for Systolic, Diastolic, MAP and
Pulse measurements during the Time Interval.

CV(%)                      
(Coefficient of Variation )

The Coefficient of Variation for Systolic, Diastolic, MAP and Pulse
measurements during the Time Interval.

SYS/DIA limits Systolic and Diastolic limits for the Awake and Sleep interval.

Readings > SYS limit(s) The percentage of the Systolic measurement values greater than
the specified Systolic limit. See “2-9-4-1 BP (Blood Pressure)
Settings" for information on specifying the Systolic Blood
Pressure Limit.

Readings > DIA limit(s) The percentage of the Diastolic measurement values greater
than the specified Diastolic limit. See "2-9-4-1  BP (Blood
Pressure) Settings" for information on specifying the Diastolic
Blood Pressure Limit.

Highest Systolic Value The time and date of the highest Systolic value during the Time
Interval.

Highest Diastolic Value The time and date of the highest Diastolic value during the Time
Interval.

Lowest Systolic Value The time and date of the lowest Systolic value during the Time
Interval.

Lowest Diastolic Value The time and date of the lowest Diastolic value during the Time
Interval.
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2-6-2 BP Data List
The BP Data List function displays individual blood pressure measurement within an open data file in

tabular form. With the BP Data List, you may input measurement comments, exclude/include a

measurement within the graphics and statistics or link a measurement to the beginning of the Trends

Screen.

The following table defines each heading within the Blood Pressure Data List:

Item Description
# Measurement number

DATE/TIME Date and time of the measurement

SYS Systolic blood pressure

DIA Diastolic blood pressure

MAP Mean arterial blood pressure, obtained by MAP=DIA+(SYS-DIA)/3

PUL Pulse

DP Double Product, obtained by DP=SYS∗ PUL/100

STATUS The status line has 3 positions. When filled with a character other than “–”,
each denotes a specific occurrence or condition.

Position 1
BP method,
O or K

Denotes the BP method used for the specific measurement. “K” refers to
Korotkoff method, “O” refers to oscillometric method.

Position 2
E (Event)

Indicates that data was measured when the monitor’s EVENT button was
activated.

Position 3
Error code

Denotes the specific error code that occurred during the monitoring session,
see “3-1  Measurement Errors”.

Exclude When this column has an “X”, the measurement has been excluded from the
statistics and graphs.

Comments Space provided for user to enter patient diagnostic notations up to 20
characters.

Vertical scroll
bar

The vertical scroll bar on the right hand side of the screen helps scroll through
the measurements.  This may also be performed with the up and down arrow
keys, as well as the mouse.

Save button Saves any edits, i.e. comments, exclusions or inclusions.

Close button Closes the screen.                                                                                        
Note:  Edits (comments, exclusions or inclusions) will not be saved.

Help button Opens the Blood Pressure Data List help screen.
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Figure 9: Blood Pressure Data List display

2-6-2-1 Excluding/Including BP Measurements
It is useful to exclude a measurement from the Blood Pressure Data List in cases where the

measurement is clearly incorrect. The software provides a simple way to include or exclude

measurements while viewing a list. When a measurement is excluded from the Blood Pressure Data

List, it will not be included in any of the software’s statistical or graphical analysis functions.

A measurement can be included or excluded by clicking on the measurement in the column labeled

Exclude. An “X” in the Exclude column indicates that the measurement is excluded.  A “-“ indicates

that the measurement is included.

In some cases the software automatically excludes measurements if an error occurred during the

reading. Measurements that have been automatically excluded are displayed with and “X” in the

Exclude column and cannot be included by the user.

Note: Measurements that have been excluded are not deleted from the data file.

2-6-2-2 Entering Comments
Comments, such as information taken from the patient activity diary, may be entered into the data

file. To enter a comment, complete the steps below:

Step 1 Click the measurement in the column labeled Comments.

Step 2 Type your comments – maximum 20 characters.

Note: You may write over any of the automatic measurement error comments.

Step 3 Press the Enter key or click a different measurement to confirm the comments.

Step 4 To save the comments, click the Save button before closing the Blood Pressure Data
List screen.

Step 5 Click the Close button if you do not want to save the comments.
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2-6-2-3 Linking to Trends Screen
A measurement may be linked to the Trend Graph by highlighting an individual measurement and

then closing the Blood Pressure Data List. When opened, the Trends Screen will be aligned with the

time of the highlighted measurement in the Blood Pressure Data List. This feature may be used to

pinpoint the position of an individual measurement on the Trend Graph.

2-6-3 Trends Screen
The Trends function is used to visualize trends in a patient’s blood pressure, pulse, MAP and DP

calculation over time. The Trends Screen is a useful diagnostic tool to determine nocturnal dips and

related peaks and troughs in the patient’s circadian rhythm.

The Trends function provides graphic representation of the data file. The Trends function is

dependent on the following parameters:

♦  Partial Analysis

♦  BP Mode (Measurement Method)

♦  Sleep Interval

♦  Blood Pressure Limits

The following four trends can be displayed in the Trend function:

♦♦♦♦ Systolic/Diastolic Blood Pressure (BP Trend):  
The vertical axis represents millimeters of mercury (mmHg) and the horizontal axis

represents time. A vertical dotted line connects the measurement’s systolic and diastolic

pressures.  This line may be used to estimate the pulse pressure2.

♦♦♦♦ Pulse (Pulse Trend):             
The vertical axis represents beats per minute (BPM) and the horizontal axis represents

time.

♦♦♦♦ Mean Arterial Blood Pressure (MAP Trend):    
The vertical axis represents millimeters of mercury (mmHg) and the horizontal axis

represents time. The MAP Trend may be displayed on its own or in combination with the

BP Trend. If the MAP Trend is combined with the BP Trend, it will appear between the

Systolic and Diastolic Trend lines.

♦♦♦♦ Double Product:  
The vertical axis represents mmHg･bpm and the horizontal axis represents time.

                        

                                                  

2 The Pulse Pressure is the difference between the Systolic and Diastolic blood pressures.
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Delimitation, Scroll Bar and Linking

♦♦♦♦ Partial Analysis:  
When the Partial Analysis feature is enabled, red bands will appear on all the Trend

Graphs highlighting the period and data specified within the Partial Analysis parameters.

♦♦♦♦ Sleep: 
When the Sleep interval is identified, black bands will appear around all the Trend

Graphs highlighting the specified Sleep interval.

♦♦♦♦ Blood Pressure Trend BP Limits:  
When the Systolic and Diastolic Blood Pressure Limits are specified, lines are drawn

horizontally across the Blood Pressure and Mean Arterial Blood Pressure trends at the

specified limits.  These lines may be used to determine when the patient exceeds the

user defined limits during the monitoring session.

♦♦♦♦ Scroll bar/Linking:  
The scroll bar at the bottom of the Trends Screen allows you to scroll through the Trend

Graphs.  You may also link the Trends Screen to the Blood Pressure Data List by

aligning the left hand side of a Trends Screen with the vertical line of an individual blood

pressure measurement.  When the Blood Pressure Data List is displayed, the aligned

measurement will be selected.

Figure 10: Trends Screen with all positions specified

The Trends Screen can be modified in two ways:

(1)  Trends selection

(2)  Scaling

Once you have opened and selected a data file, follow the below to view, scale, customize and print

the Trends Screen.
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2-6-3-1 Viewing the Trends

Step 1 Select the View menu.

Step 2 Select the Trends sub-menu.

Step 3 You may print the Trends Screen by selecting the Print menu on the Trends toolbar.

Step 4 Click the Windows™ close button in the top right corner to close the Trends Screen.

2-6-3-2 Scaling the Screen
The Trends Screen may be scaled to have some or all of the data fit on the screen.  To scale the

Trends Screen, complete the following steps:

Step 1 Select the Zoom drop-down menu on the Trends toolbar.

Step 2 Select a scale to view the screen:  All data, 1, 3, 6 or 12 hours.

2-6-3-3 Trend Display:  Positioning Trends
The Trends Screen may be customized to show one or more trends on the screen simultaneously in

any order.  The trends positions may be set to:

♦ Blood Pressure:  Systolic/Diastolic, MAP, Pulse

♦ Double Product
♦ Blank:  When a position is set to Blank, the other specified trends will expand to fit the   

screen.

Figure 11:  Trend Page Selection dialog box
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To customize the Trends Screen, complete these steps:

Step 1 Select the Select menu on the top left hand corner of the Trends toolbar.

Step 2 Highlight the Trend Page Template you want to view and click the OK button or
double click the Trend Page Template.

If an existing template does not meet the requirements, you may create a new template or edit an

existing one.

 

2-6-3-4 Creating a New/Edit Trends Template
The new and edit Trend Page features are quite similar. The instructions for these features have

been combined.

Figure 12: Trend Page Setup dialog box

Step 1 Select the Select menu on the top left hand corner of the Trends toolbar.

Step 2 To create a new Trend template, select New and go to step 3.
To edit a Trend Page, go to step 4.

Step 3 Input a name for the New Trend Page and go to step 6.

Step 4 Highlight the Trend Page template you want to edit and click the Edit button.

Step 5 Enter a name for the Trend Page.

Step 6 Select Position 1.

Step 7 Select the Trend to reside in Position 1. The position will be set with the specified
trend.   

Note: There are three sub trends to the Blood Pressure Trend: 1) Systolic/Diastolic 2)
MAP 3) Pulse.
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Figure 13: Blood Pressure Trend Setup dialog box

Step 8 Repeat steps 6-7 to set positions 2, 3, and 4.

Step 9 To save your trend template, click the Save button

Step 10 To cancel the operation, click the Cancel button .

2-6-4 Correlation Plots
The Correlation screen offers a convenient way to view the relationship between the Blood Pressure

parameters.  It also assesses overall performance of the patient’s cardiovascular system. Both Full

and Partial Analysis Correlation Plots may be viewed for the following relationships:

1) Systolic versus Diastolic

2) Systolic versus Pulse (Heart Rate)

3) Statistical Data3: Systolic, Diastolic, Pulse

– Mean, " m "

– Standard Deviation, " s’ "

– Correlation Coefficient, " r "

– Regression Line

The vertical axis represents systolic pressure, the horizontal axis represents the diastolic pressure

on the left hand graph and pulse on the right hand graph. All the graphs have scales of 0 to 300

mmHg.  
Note: If Partial Analysis is enabled, four graphs will appear. The first two graphs on the

left hand side of the screen, in blue, are based on Full data. The second pair of
graphs, in red, on the right hand side of the screen is created from valid data
specified within Partial Analysis parameters.

Each measurement recorded represents a dot on the screen. The vertical position of the dot is equal

to the systolic value on both graphs. The horizontal position on graph 1 is equal to the diastolic value

and on graph 2, the pulse. The clusters of dots are created by the overlapping of recorded

                                                  

3 Statistics and graphs are effected by the deleting and inserting of measurements in the BP

Data list.
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measurements. Measurement statistics, Mean " m ", Standard Deviation " s’ " and Correlation

Coefficient “ r ” values are shown on the bottom of the screen.

Figure 14: Correlation Plots display
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2-6-5 Histograms
The Histograms screen offers a convenient way to quickly review the overall magnitude and

distribution of the systolic, diastolic, mean arterial blood pressures and pulse (heart rate)

measurements. The following Histograms are available:

♦  Systolic Blood Pressure:  
Full Analysis in blue, Partial Analysis overlaid in red.

♦  Diastolic Blood Pressure:  
Full Analysis in blue, Partial Analysis overlaid in red.

♦  MAP, Mean Blood Arterial Pressure:  
Full Analysis in blue, Partial Analysis overlaid in red.

♦  Double Product:  
Full Analysis in blue, Partial Analysis overlaid in red.

♦  Pulse:  
Full Analysis in blue, Partial Analysis overlaid in red.

♦  Statistical Data4:  
MEAN (m) and SD (s’) for: SYS, DIA, MAP, DP and PULSE. Full Analysis is in blue,
Partial Analysis in red.

The vertical scale represents 0 to 300 (mmHg or BPM) on all graphs except Double Product. The

horizontal scale represents the percentage of total readings that occurred at the corresponding

vertical level. The Histograms are displayed in blocks that represent a range of readings.

Figure 15: Histograms display

                                                  

4  Statistics and graphs are effected by the deleting and inserting of measurements in the BP

Data list.
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2-6-6 Circadian Rhythm
The Circadian Rhythm screen shows the circadian rhythm of the systolic and diastolic blood

pressures, and pulse (heart rate); obtained using the 24-hour cosinor analysis. The analysis starting

time coincides with the start time specified for the Full Analysis interval.

The Circadian Rhythm screen also shows the amplitude and peak value of the cosine wave based

on the 95% confidence interval.

The systolic blood pressure data is indicated in red, the diastolic blood pressure data, in blue, and

the pulse data , in yellow.

Figure 16: Circadian Rhythm display



29

2-6-7 HIB Analysis
The HIB analysis screen shows two graphs arranged vertically.

The upper graph shows the hyperbalic area (in red) exceeding the user-defined hyperbalic limits for

the systolic and diastolic blood pressures, and the numerical data converted into a one-day period.

The lower graph shows the hypobalic area (in red) not reaching the user-defined hypobalic limits for

the systolic and diastolic blood pressures, and the numerical data converted into a one-day period.

For both graphs, the analysis starting time coincides with the start time specified for the Full Analysis

interval.

Note: For details on the hyperbalic and hypobalic limits, see “2-9-4-1 BP (Blood
Pressure) Settings”.

Figure 17: HIB analysis display
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2-6-8 Patient Information
The Patient Information screen is used to store information on patients and their treatment. This is

also the input screen for the patient’s Sleep interval.

Figure 18: Patient Information display

The Patient Information screen has the following data fields:
(The characters referred to in the table below include CRs and spaces.)

Field Description
Recorder ID Recorder ID refers to the monitor identification number. The Recorder ID

cannot be modified in this screen. It is established during the recorder setup
prior to the monitoring session. See “2-7-3 Programming the Monitor’s
Intervals and Conditions”.

For the TM-2420, the ID number is fixed to “1”.

Date Date corresponds to the first measurement date in the patient record. Date
cannot be modified in this screen. It is automatically set at the time the
measurement was recorded.

Time Time corresponds to the first measurement time in the patient record. Time
cannot be modified in this screen. It is automatically set at the time the
measurement was recorded.

File File refers to the name of the file. It is initially defined by the user at the time of
data retrieval. See “2-7-1 Retrieving Data from the Monitor”.

Name There are two name fields. Enter up to 20 characters for the patient name
when the data is retrieved. Selecting this field allows changes to the patient
name. Enter up to 60 characters for the physician name. The physician’s name
may be entered automatically by selecting the List button. See “2-9-2
Physician List”.

Address There are two address fields. The patient address field may be filled in
manually. The physician address field may either be filled in manually, or
automatically by selecting the List button. See “2-9-2  Physician List”.
Up to 50 characters can be used for each address field.

Phone There are two telephone fields. The patient phone field may be filled in
manually. The physician phone field may either be filled in manually, or
automatically by selecting the List button. See “2-9-2  Physician List”.
Up to 20 characters can be used for each phone field.

Soc. Sec. # Field for the patient’s social security number. Up to 20 characters can be used.
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Field Description
Insurance Field for the patient’s insurance information. Up to 20 characters can be used.

Medicare # Field for the patient’s Medicare or Medicaid number or other health care
number. Up to 20 characters can be used.

Medications Field for the patient’s medications. Up to 60 characters can be used.

Age Field for the patient’s age. Up to 10 characters can be used.

Sex Field for the patient’s sex. Up to 10 characters can be used.

Height Field for the patient’s height. Up to 10 characters can be used.

Weight Field for the patient’s weight. Up to 10 characters can be used.

Comments Field for comments on the patient’s condition, treatment or other notes. Up to
400 characters can be used. The scroll bar will automatically be activated
when additional space is required.

Sleep The Sleep field is used to define the sleep parameter. Begin refers to the time
the patient goes to sleep. End refers to the time the patient wakes up. The 24-
hour clock (military time) must be used when inputting the sleep times. For
example, 11 p.m. equals 23:00, Midnight equals 00:00, and 9 a.m. equals
09:00. Use a colon ":" between hours and minutes.

Follow the instructions below to view, edit and print the Patient Information screen.

Step 1 Select the View menu.

Step 2 Select the Patient Information sub-menu.

Step 3 To edit a field, select the appropriate field and input the information.

Step 4 To save the edits and close the Patient Information screen, click the Save button.

Step 5 To cancel the edits and close the Patient Information screen, click the Cancel button.

Note: For some types of printers, the number of printed characters may be different from
the number of displayed characters.

2-7 Recorder Menu
The Recorder menu may be used to retrieve data from the monitor, set the monitor’s intervals and

conditions and clear the data in the monitor’s memory. With the monitor and the processor

connected to the computer, the following options are provided:

1) Retrieve data

2) Condition setup

3) Clear data

Note: • Be sure to perform the default settings before executing the Recorder menu.
About the default settings, see “2-9-4-2 Serial Port” and “2-9-4-3 Recorder Type”.

• If communications cannot be made due to improper connection or some other
failure, see “3  TROUBLESHOOTING”.
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2-7-1 Retrieving Data from the Monitor

Figure 19: Recorder-Retrieve Data dialog box

See below for the description of each field on the Recorder-Retrieved Data dialog box.

Field Description

Recorder ID Recorder ID is set in the monitor’s memory prior to the monitoring
session.

Start Date Date of first measurement in the monitor’s memory.

Start Time Time of first measurement in the monitor’s memory.

Patient Name Field for the patient’s name.

Convert Data Creates a CSV file automatically when checked.

Status Status line offers comments on the present stage of the data retrieving
process, e.g. “connected” or “retrieving data”.

With the monitor and the processor connected to the computer, you may retrieve data from the

monitor by completing the steps below:

Step 1 Select the Recorder menu.

Step 2 Select the Retrieve data sub-menu.

Step 3 Select the Patient name field and input the patient’s name.  The name will appear in
the Name field on the Patient Information screen.

Note: You must input a patient name or the data can not be retrieved. To exit the
Retrieve Data dialog box prior to retrieving the data, click the Windows™ close
button in the top right corner of the Recorder–Retrieve Data dialog box.

Step 4 Click the Retrieve Data button.

Step 5 Select the File Name field and enter a file name.

Step 6 Select the Drive and Directory where the file should be saved.
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Step 7 Click the OK button.

Note: To view a retrieved file, you must open it.

2-7-2 Clearing The Monitor’s Memory
The monitor’s memory should be cleared before each monitoring session. With the monitor and the

processor connected to the computer, you may clear the measurement data stored in the monitor by

completing the steps below:

Step 1 Select the Recorder menu.

Step 2 Select the Clear Data sub-menu.

Figure 20: Recorder - Clear Data dialog box

Step 3 To clear the monitor's memory, click the OK button.

Step 4 To not clear the monitor's memory, click the Cancel button.

CAUTION:  Cleared data cannot be recovered.
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2-7-3 Programming the Monitor’s Intervals and Conditions
2-7-3-1 TM-2420/TM-2421 Setup
With the monitor and the processor connected to the computer, you may setup or change the

following monitor condition and interval settings:

Item Definition

Recorder ID number Monitor (or patient) ID number (01 through 99). This is useful
when more than one monitor is used in the same clinical setting.

Time Sets monitor’s internal clock.

Date Sets monitor’s internal calendar.

Display On/Off Turns the monitor display on or off during automatic
measurement session. It may not be desirable for the patient to
see the measurement results. Some patients become nervous
when they see the measurement results. This may affect their
blood pressure readings.

Buzzer On/Off Sets whether or not the monitor will beep 10 seconds prior to the
start of a measurement.

PERIOD A 24-hour day may be broken up into 4 periods. For a more
detailed explanation, see monitor’s instruction manual.

START The Time of the first (1) period is the start and end time of the
monitoring session.

Note: When only the Time of the first (1) period is set, the
monitoring session is performed at the same interval for
24 hours.

The Time of the second (2) period, if set, is the start of the
second period and end of the first. The Time of the third (3)
period, if set, is the start of the third period and end of the
second. The Time of the fourth (4) period, if set, is the start of
the fourth period and end of the third.

Note: You do not need to program all periods.

INTERVAL The Interval is the number of minutes between each
measurement within the specific period.

The Setup sub-menu may be used to program the monitor’s intervals and conditions.  The monitor is

programmed in 24-hour segments, with the End Time for the last Period defaulting to the Period One

(1) Time that is both the Start and End Time for the monitoring session.  Please also note that the

Periods must be defined consecutively, i.e. set Period 1 then Period 2, then Period 3, not Period 1

then Period 3.  To program the monitor, follow the steps below:

Note: The monitor, processor and cable must be connected to the computer correctly,
see “2-2 Communication Between the Monitor and the Software”.

Step 1 Select the Recorder menu.

Step 2 Select the Setup sub-menu. The Recorder Setup dialog box appears.
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Figure 21: TM-2420/TM-2421 Recorder Setup dialog box

Step 3 Select the Recorder ID field. Input a Recorder ID number between 1 to 99.

Step 4 Select the Display check box to set the display to On or Off.

Step 5 Select the Buzzer check box to set the buzzer On or Off.

Step 6 Select the Time field for Period One (1) and enter the time you want the monitoring
session to begin.  Use military time to set the Time.

Note: The Time for Period One (1) also defines the End of the monitoring session 24
hours later.  See examples at the end of this section.

Step 7 Select the Interval drop-down menu for Period One (1) and set the measurement
Interval for Period One (1) to:  OFF, 15, 35, 5, 10, 15, 205, 30, 60 or 1205 minutes.

Step 8 If you want to program a second period, go to step 9.
If you do not want to program a second period, go to step 17.

Step 9 Select the Time field for Period Two (2) and enter the time you want for this period;
this will also set the end for period One (1). Use military time to set the Time. See    
examples at the end of this section.

Step 10 Select the Interval drop-down menu for Period Two (2) and set the measurement
Interval for Period Two (2) to:  OFF, 1, 3, 5, 10, 15, 20, 30, 60 or 120 minutes.

Step 11 If you want to program a third period, go to step 12.
If you do not want to program a third period, go to step 17.

Step 12 Select the Time field for Period Three (3) and enter the time you want for this period;
this will also set the end for period Two (2). Use military time to set the Time. See
examples at the end of this section.

                                                  

5 The 1 and 3-minute measurement intervals are available only with the TM-2420/TM- 2421.

The 20-minute measurement interval is available only with the TM-2421.

The 120-minute measurement interval is available only with the TM-2421/ TM-2430.
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Step 13 Select the Interval drop-down menu for Period Three (3) and set the measurement
Interval for Period Three (3) to:  OFF, 1, 3, 5, 10, 15, 20, 30, 60 or 120 minutes.

Step 14 If you want to program a fourth period, go to step 15.
If you do not want to program a fourth period, go to step 17.

Step 15 Select the Time field for Period Four (4) and enter the time you want for this period;
the end period for Period Four (4) will be the Time for Period (1). Use military time to
set the Time.  See examples at the end of this section.

Step 16 Select the Interval drop-down menu for Period Four (4) and set the measurement
Interval for Period Four (4) to:  OFF, 1, 3, 5, 10, 15, 20, 30, 60 or 120 minutes.

Step 17 If the intervals are set correctly, click the OK button to confirm the programming. If
they are not correct, reset them, or go to step 18.

Step 18 To cancel the programming and close the Recorder–Setup dialog box, click the Cancel button.

2-7-3-2 TM-2430 Series Setup
The recorder setup for the TM-2430 series is similar to the TM-2420/TM-2421 except that it includes

two additional options for setting the BP measurement intervals as shown in Figure 22.

Figure 22: TM-2430 series Recorder-Setup dialog box

Description of each mode is as follows:

Mode 1 07:00-21:59 The measurement is performed every 15 minutes.
22:00-06:59 The measurement is performed every 30 minutes.

Mode 2 The AUTO ON/OFF key is pressed at rising and going to bed so that the measurement

intervals are changed and the time during sleep can be distinguished on the data.

When the “S” is off, the measurement is performed every 15 minutes.

When the “S” is displayed, the measurement is performed every 30 minutes.

Mode 3 The measurement interval can be changed six times within a maximum of 24 hours. (The

monitor can store six measurement intervals (periods) in 24 hours. A period consists of a

start time and interval.)
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2-7-3-3 Examples of Programming the Monitor

Note: The procedure is the same for the TM-2420/TM-2421/TM-2430, except periods 5
and 6, which are  available only with the TM-2430.

(A) Example:  Programming the Monitor for One (1) Period
Suppose that the start time of the monitoring session is 09:00 and you would like the monitor to

measure the patient's blood pressure every 30 minutes. Remember that the Time for Period One (1)

also defines the End of the monitoring session. The end time for Period 1 will default to the Time for

Period One (1), in this case 09:00.

PERIOD TIME INTERVAL DURATION
1 09:00-09:00 30 minutes 24 hours

Total: 24 hours

The following is the recorder setup according to these instructions.

Note: Set Period One (1) only. Leave the other Periods as “-”.

PERIOD START INTERVAL

1 9 30 minutes

2 - -

3 - -

4 - -

5 - -

6 - -

Figure 23: Monitor programming example 1
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(B) Example: Programming the Monitor for Three (3) Periods
Suppose that the start time of the monitoring session is 09:00 and you would like the monitor to

measure the patient's blood pressure every 30 minutes until 22:00, and from 22:00 to 07:00 once an

hour, and from 07:00 you would like the blood pressure measured every 15 minutes. Remember that

the Time for Period One (1) also defines the End of the monitoring session. The end time for Period

Three (3) will default to the Time for Period One (1), in this case 09:00.

PERIOD TIME INTERVAL DURATION
1 09:00-22:00 30 minutes 13 hours
2 22:00-07:00 1 hour 9 hours
3 07:00-09:00 15 minutes 2 hours

Total: 24 hours

The following is the recorder setup according to these instructions.

Note: Set Periods One (1), Two (2) and Three (3) only. Leave the other Periods as “-”.

PERIOD START INTERVAL

1 9 30 minutes

2 22 1 hour

3 7 15 minutes

4 - -

5 - -

6 - -

Figure 24: Monitor programming example 2
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(C) Example: Programming the Monitor for Four (4) Periods
Suppose that the start time of the monitoring session is 09:00 and you would like the monitor to

measure the patient's blood pressure every 30 minutes until 22:00, and from 22:00 to 23:00 you

want the monitor OFF so that the patient may sleep, and from 23:00 to 06:00 you would like the

patient's blood pressure measured once an hour, and finally from 06:00 you want the blood pressure

measured every 15 minutes. Remember that the Time for Period One (1) also defines the End of the

monitoring session. The end time for Period Four (4) will default to the Time for Period One (1), in

this case 09:00.

PERIOD TIME INTERVAL DURATION
1 09:00-22:00 30 minutes 13 hours
2 22:00-23:00 OFF 1 hours
3 23:00-06:00 1 hour 7 hours
4 06:00-09:00 15 minutes 3 hours

Total: 24 hours

The following is the recorder setup according to these instructions.

Note: Set Periods One (1), Two (2), Three (3) and Four (4). Leave the other Periods as
“-”.

PERIOD START INTERVAL

1 9 30 minutes

2 22 OFF

3 23 1 hour

4 6 15 minutes

5 - -

6 - -

Figure 25: Monitor programming example 3
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2-7-3-4 UA-767PC Setup
When the UA-767PC connected to a personal computer, times to generate a beeping sound can be

set.

To set the times, complete the following steps:

Step 1 Select the Recorder menu.

Step 2 Select the Setup sub-menu. The Recorder Setup dialog box appears.

Figure 26: UA-767PC Recorder-Setup dialog box

Step 3 Enter times to generate a beeping sound.

Note: The same time can not be entered in different boxes. Enter different times for
each box.

Step 4 Click the OK button to confirm the settings. If the settings are not correct, reset them
or go to Step 5.

Step 5 To cancel the settings and close the dialog box, click the Cancel button.

2-7-4 Blood Pressure Measurement (Available only with the UA-767PC)
When the UA-767PC connected to a personal computer, blood pressure measurement can be

started from the computer.

Step 1 Select the Recorder menu.

Step 2 Select the Blood Pressure Measurement sub-menu.

Step 3 Blood pressure measurement will be started.
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2-8 Report Menu
Custom report formats may be saved for future use through the Report menu. The following

functions are available in the Report dialog box:

♦  Create a new report template

♦  Edit an existing report template

♦  Delete an existing report template

♦  Save an existing template as the default report style

♦  Print a user defined report

♦  Print a “Mini” report

♦  Close the Report dialog box

Figure 27: Report dialog box

To open the Report dialog box, print a report, create a new report template or edit an existing

template, select the Report menu on the main menu.
Note: Not available with the UA-767PC.
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2-8-1 Creating a New Report Template

Step 1 Click the New button on the Report dialog box. The Report Setup dialog box will
appear.

Figure 28: Report setup dialog box

Step 2 Type the Report Name.

Step 3 Edit the Report Heading. This heading will appear on the top of every page along
with the file name and time the file is printed.

Step 4 Select the Text Data you want included in the report by checking the appropriate
boxes.

Note: You may check all or none of these boxes. An unchecked box will not print; a
checked box will print.

Step 5 Select the Graphical Data you want included in the report by checking the
appropriate boxes.

Note: You can check all or none of these boxes. An unchecked box will not print; a
checked box will print.

Step 6 Select the Measurement Method to base the report on by clicking the appropriate
radio button.

Step 7 Save the report template by clicking the Save button.

Step 8 If you do not want to save the report template, click the Cancel button.
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2-8-2 Editing an Existing Report Template

Step 1 Highlight the report template you want to edit.

Step 2 Click the Edit button. The Report Setup dialog box will appear.

Step 3 Edit the Report Name.

Step 4 Edit the Report Heading. The Report Heading will appear on the top of every page
along with the file name and time the file printed.

Step 5 Edit the selected Text Data you want included in the report by checking or
unchecking the appropriate boxes.

Note: You may check all or none of these boxes. An unchecked box will not print; a
checked a box will print.

Step 6 Edit the selected Graphical Data you want included in the report by checking or
unchecking the appropriate boxes.

Note: You may check all or none of these boxes.  An unchecked box will not print; a
checked box will print.

Step 7 Edit the selected Measurement Method to base the report on by checking or
unchecking the appropriate radio button.

Step 8 Save the report template by clicking the Save button.

Step 9 If you do not want to save the report template, click the Cancel button.

2-8-3 Deleting an Existing Report Template
Step 1 Highlight the report template you want to delete in the Report dialog box.

Step 2 Click the Delete button. The highlighted report template will be deleted.

Step 3 To cancel this operation, click the Cancel button.

2-8-4 Saving a Default Report Template for Printing
Step 1 Highlight the report template you want to save as the default report.

Step 2 Click the Save as default report button. The specified report template will be saved
as the default report and will be appeared first every time the Report dialog box is
opened.

 

2-8-5 Printing an Existing Report Template
Step 1 To print the Default Report Template, click the Print report button.

Step 2 To print a report template other than the Default Report Template, highlight the
desired report template in the Report dialog box and click the Print report button.

2-8-6 Closing the Report dialog box
Step 1 Click the Close button.
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2-9 Options Menu
The Options menu may be used to access default and various formatting screens within the software.

The following Options features are available:

Menu See Description
Report Formats “2-8 Report Menu” The Report formats may be used to create and

save custom report formats.

Physicians List “2-9-2 Physician List” The Physicians list may be used to store contact
information on the patient’s physician, i.e. address
and phone number, so that the Physician fields in
the Patient Information screen may be quickly
updated.

Trend Display “2-6-3-3 Trend Display:
Positioning Trends”

The Trend Display may be used to customize the
Trends Screen.

Default Settings “2-9-4 Default Settings” There are three default settings:

1) BP settings (Blood Pressure settings) which may
be used to set the default BP mode and BP
limits.

2) Serial port which may be used to set the
communication port for interfacing with the monitor.

3) Monitor type to be used.

2-9-1 Report formats
See “2-8 Report Menu”.

2-9-2 Physician List
The Physicians List is used to store contact information for multiple physicians. This will save time

from repetitive data input.

Figure 29: Physician List dialog box

Step 1 Select the Options menu.

Step 2 Select the Physician List sub-menu.
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The following instructions outline the various Physician List features available.

2-9-2-1 Adding a New Physician to the List

Figure 30: Physician Entry dialog box

Step 1 Click the New button on the Physician List dialog box. The Physician Entry dialog box
will appear.

Step 2 Enter the appropriate data.

Note: All fields must be completed.

Step 3 Save the new physician template in the list by clicking the Save button.
 If you do not want to save the new physician, click the Cancel button.

2-9-2-2 Editing an Existing Physician in the List
Step 1 Highlight the physician’s name you want to edit.

Step 2 Click the Edit button. The Physician Entry dialog box will appear.

Step 3 Select the field to edit and then type the new data.

Note: All fields must be completed.

Step 4 Save the edited physician template by clicking the Save button.
 If you do not want to save the edited physician, click the Cancel button.

2-9-2-3 Deleting an Existing Physician in the List
Step 1 Highlight the physician’s name you want to delete.

Step 2 Click the Delete button. The highlighted physician’s name will be deleted.

Step 3 If you do not want to delete the physician template, click the Cancel button.

2-9-3 Trend Display
See “2-6-3-3 Trend Display: Positioning Trends”.



46

2-9-4 Default Settings
There are three default settings in this software:

1) Blood Pressure

2) Serial Port

3) Recorder Type

2-9-4-1 BP (Blood Pressure) Settings (Available only for TM-2420/TM-2421 and TM-2430 data)
Edit the Default Blood Pressure Settings as follows:

Step 1 Select the Measurement Method (BP Mode).

Step 2 Enter data for each value. The following is the description of each value.

Hyperbalic limit:

The percentage of readings exceeding the specified Systolic and Diastolic limits for
the Awake and Sleep interval will be calculated and noted both in the Summary Data
and printed reports.
The values are used as “limits” for HBI analysis.

Hypobalic limit:

The percentage of readings not reaching the specified Systolic and Diastolic limits for
the Awake and Sleep interval will be calculated and noted both in the Summary Data
and printed reports.
The values are used as “limits” for HBI analysis.

Step 3 To save the edits, click the Save button.

Step 4 To cancel the edits, click the Cancel button.

Figure 31: Default Blood Pressure Settings dialog box
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2-9-4-2 Serial Port
The serial port is used to communicate between the monitor and the computer. The serial port

setting and the port used for communication must be the same.

Figure 32: Default Serial Port Selection dialog box

2-9-4-3 Recorder Type

Figure 33: Default Recorder Type dialog box

The default Recorder Type function is used to select the type of monitor the software will

communicate with for all Recorder functions. This function does not affect which type of data files the

software can analyze.

2-10 On-line Help
Help screens are available for on-line software assistance. There are three ways to access the Help

function.

   

1) Select the Help menu on the Menu bar.

2) Click Help buttons which appear on various dialog boxes throughout the software.

3) Press the F1 key at any point during the operation of the software.
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3. TROUBLESHOOTING
3-1 Measurement Errors
The following tables list the error messages that may occur during a monitoring session and offer

information on possible causes and corrections.

Measurement errors may be shown on the blood pressure data list display and printed text data. If

an error occurs (indicating by asterisks), corrective measures must be taken to use this software.

3-1-1 TM-2420/TM-2421 Error Codes

ERROR CODE POSSIBLE CAUSE CORRECTION
E01 The microphone has become

disconnected or there has been
excessive body motion.

Remove and reconnect the microphone
connector at the front of the monitor.

E02 Air leak Check that the air hose plug is tightly
connected to the air connector located
at the front of the monitor.
Check the connection between the air
hose plugs and the air bladder.
Check the air bladder for leaks.

E04 Low Battery, “c”, shown in the
monitor display.
The monitor will not take a
measurement, print data, or
download data until the monitor is
charged.

Plug the AC adapter in the monitor.
The “c” shown on the display will
disappear after 30 minutes. Wait the full
60 minutes charging time to ensure that
the battery is fully charged.
Note: The monitor will hold all stored
readings in memory for two weeks after
the appearance of the low battery
indicator.

E05 Measurement time exceeds 100
seconds.
(Inflation time error)

Check E01 and E02 procedures.
Reposition the lower microphone and
then correlate it to the subject.
Check that the air hose is not held down
by a constrictive strap or similar
restraint which may disrupt the air flow.

E06 Pressurization greater than 320
mmHg

Confirm that the subject is not moving
during the measurement.
Clear the memory.
Caution: All measurement data will
be erased.
After clearing the memory, take one
measurement. If the cuff pressurizes to
approximately 195 mmHg, the system is OK.
Reset the monitor by gently inserting a
paper clip in the hole located on the
bottom of the monitor.
Caution: All measurement data, as
well as programmed intervals and
conditions will be erased.
If the monitor stops and then continues
to inflate above 260 mmHg, return the
unit to A&D for service.
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ERROR CODE POSSIBLE CAUSE CORRECTION
E07 Manual stop The measurement was manually

interrupted by depression of the red
Start/Stop button.

E08 Korotkoff sounds are
undetectable.

Check that the lower microphone is
affixed with the sensing side (skin side)
facing the patient’s arm.
Note: The microphone should always
be taped to the arm with the supplied
affixing tape.  Place "X" of tape over the
top of the microphone.

E11 More than 256 Korotkoff sounds
are measured.

Check for a break in the microphone
lead.  Check for external damage to the
microphone.  Microphone circuit may be
damaged.
Note: If a break in the microphone lead
or external damage has occurred, the
microphone assembly must be
replaced.

E20 Pulse Error
Pulse less than 35 beats or more
than 200 beats per minute.

Check the position of the lower
microphone and then re-correlate it to
the subject.
Note: Certain physiological conditions
or pharmaceutical treatment may
excessively reduce or increase a pulse
rate.  In cases of excessively low pulse
rates, have the subject walk or stand a
few minutes to raise the pulse rate
above 35 beats per minute.

E21 Diastolic greater than 160 mmHg
or less than 40 mmHg.

Outside of normal physiological
parameters.

E22 Systolic greater than 280 mmHg
or less than 60 mmHg.

Outside of normal physiological
parameters.

E23 Difference between systolic blood
pressure and diastolic blood
pressure less than 10 mmHg.

Outside of normal physiological
parameters.

E24 Difference between systolic blood
pressure and diastolic blood
pressure greater than 150
mmHg.

Confirm that the subject is not moving
during measurement.  Reposition the
lower microphone and then correlate it
to the subject.

Note: If a measurement error occurs (other than E08) when the “Auto” mode is set, the
monitor will automatically take a 2nd measurement. If a second measurement
error occurs, a 3rd measurement will not be taken. The monitor will return to its
programmed interval.
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3-1-2  TM-2430 Series Error Codes

ERROR CODE POSSIBLE CAUSE CORRECTION
E00 Clock parameters have not been

set.
Enter clock parameters.

E03 An error code is displayed
without cuff inflation.

Exhaust the air from the cuff completely.

E04 Measurement is stopped due to a
low battery.

Replace with new batteries. Auto mode
is quit. Restart the Auto mode if you use
it.

E05 Inflation pressure does not reach
the target pressure.

Wrap the cuff and connect to the
monitor. If the error persists, there may
be an air leak and repair is necessary.

E06 Pressurization greater than 320
mmHg.

Do not move and try to relax during the
measurement. If you can not clear the
error, repair is necessary.

E07 Controlled stop using STOP key Do not press the STOP key when
unnecessary.

E08, E10 Pulse can not be detected. Do not move and try to relax during the
measurement.

E20 Pulse less than 35 beats or more
than 200 beats per minute.

Measure the blood pressure by other
methods.

E21 Diastolic greater than 160 mmHg
or less than 40 mmHg.

Measure the blood pressure by other
methods.

E22 Systolic greater than 280 mmHg
or less than 60 mmHg.

Measure the blood pressure by other
methods.

E23 DSD greater than 150 mmHg or
less than 10 mmHg.
 (DSD = difference between
systolic blood pressure and
diastolic blood pressure)

Measure the blood pressure by other
methods.

E30, E31 Air leaks in the cuff assembly. Repair is necessary.

E32 Clock error If the error persists, repair is necessary.

E50 Pressure offset error Repair is necessary.

E52 Memory error Repair is necessary.

E53 Defective battery contact Replace batteries correctly. If the error
persists, repair is necessary.

E55, E56, E57 Exhaust error Relax and do not move during the
measurement. If this error occurs
frequently, repair is necessary.

E60 Interval setting error Enter the interval parameters correctly.

E70, 71, 72, 73 RS-232C error Re-connect the communication cable. If
the error persists, repair is necessary.

E74 Voltage decreases during
communication.

Replace batteries with new ones and
restart communication.

E75 Protocol error due to external
equipment

Re-connect the communication cable. If
the error persists, repair is necessary.
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3-2 Communication Errors
When communicating between the monitor and the PC, the following dialog box may appear if the

communication setup is not performed properly:

Figure 34: Communications Error dialog box

If this error occurs, complete the steps below:
Step 1 Click the OK button on the Error dialog box.

Step 2 Check the monitor's battery.  Recharge the battery if necessary. Or replace with new
batteries.

Step 3 Check the Default Serial Port selection.  Make sure it is correct.

Step 4 Check the Default Recorder Type selection. Make sure it is correct.

Step 5 Disconnect the monitor from the processor and reconnect them. (TM-2420/TM-2421)
Disconnect the cable and reconnect it. (TM-2430/UA-767PC)

Step 6 Attempt communication. You may need to go through the process a few times to re-
establish communication.

If the error still persists, complete the steps below:
Step 1 Exit the software.

Step 2 Disconnect the monitor from the processor and reconnect them. (TM-2420/TM-2421)
Disconnect the cable and reconnect it. (TM-2430/UA-767PC)

Step 3 Charge the monitor's battery. (TM-2420/TM-2421 only)

Step 5 Start the software.

Step 6 Check the Default Serial Port selection.  Make sure it is correct.

Step 7 Check the Default Recorder Type selection. Make sure it is correct.

Step 8 Attempt communication again.
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3-3 Missing Files
If you can not find your files in one of the File menu screens, and the files have not been deleted,

check the following:

♦  The folder specified in the Recorder-Retrieved Data dialog box is the same folder as
specified using the File | Open function.

♦  No changes have been made to the file extension .dat.

3-4 Reports Are Not Printing With the Desired BP Mode
It is important to note that the toolbar BP Mode is separate from the Report Format BP Mode

settings. The BP Mode defined in the toolbar is not necessarily the BP Mode that will be used for the

printed report. For information on how to set the BP Mode for the printed report, see “2-8-2 Editing
an Existing Report Template”.

Figure 35: Report Setup dialog box

3-5 Summary Data / Sleep Tab Data can not be Seen
Make sure that the Sleep parameters in the Patient Information screen are within the monitoring

session’s time.

For example, this problem may occur if the monitoring session is from 10:00 to 17:00, but the Sleep

interval is set to be 22:00 (Begin)-7:00 (End).
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4. PRINTOUT EXAMPLES

Figure 36: Patient information – Text data
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Figure 37: Summary data (Full and partial) – Text data
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Figure 38: Summary data (Awake and sleep) – Text data
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Figure 39: Blood pressure data  – Text data
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Figure 40: Trend graph (Blood pressure and double product) – Graphical data
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Figure 41:Correlation plots (upper) and  histogram plots (lower) – Graphical data
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Figure 42: Circadian rhythm plots (upper) and  HBI analysis plots (lower) – Graphical data
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Figure 43:  “Mini” report -1
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Figure 44:  “Mini” report -2
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5. TERMS/ABBREVIATIONS
5-1 Terms Related to Blood Pressure

Term/Abbreviation Description
Oscillometric Oscillometric method of blood pressure

measurement.
Korotkoff Korotkoff method of blood pressure

measurement.
SYSTOLIC, SYS, SBP
(Systolic Blood Pressure)

Blood pressure that occurs when the heart
contracts.

DIASTOLIC, DIA, DBP
(Diastolic Blood Pressure)

Blood pressure that occurs when the heart
expands.

MAP (Mean Arterial Blood Pressure) Mean blood pressure obtained by the
equation below.

MAP=DIA+(SYS-DIA)/3
PULSE, PUL (Pulse Rate) Number of pulses per minute.
DP (Double Product) Oxygen consumption by the heart muscles

obtained by the equation below.

DP=SYS∗ PUL/100

5-2 Terms Related to Statistics
Term/Abbreviation Description
MEAN, AV, m Arithmetic mean value of the sampled data.
MAX Maximum value in the sampled data.
MIN Minimum value in the sampled data
Hourly Average Arithmetic mean value of the data sampled

in one hour.
SD, S’ (Standard Deviation) Obtained by the equation below.

About the samples (X1, X2, ...Xn),

where n is number of samples and X is
arithmetic mean value.

SE (Standard Error) Obtained by the equation below.
About the samples (X1, X2, ...Xn),

Indicates standard deviation of the mean
error to the real values in the population.

CV (Coefficient of Variation) Obtained by the equation below.
CV=SD/mean [%]

CORRELATION Indicates the degree to which the variables
are related.
                                                     Continued
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Term/Abbreviation Description
CORRELATION: r
(Coefficient of Correlation)

Indicates the degree of linear relationship
between two variables. It ranges from +1 to
-1. A correlation of +1 means that there is a
perfect positive linear relationship between
variables.

Sys – dia In the plotted 24-hour blood pressure data,
indicates high blood pressure using the limits
of the systolic and diastolic blood pressures.

Sys – pul In the plotted 24-hour blood pressure data,
indicates the degree to which the pulse and
the systolic blood pressure are related.

Reg. Line (Regression Line) A line drawn through a scatterplot of two
variables  so that the line comes as close to
the points as possible.

Histogram A graphical representation of a frequency
distribution by means of rectangles.
The widths represent intervals. The heights
represent the number of observations
occurring in each interval.

F Full analysis
P Partial analysis

5-3 Terms Related to Biological Rhythm
Term/Abbreviation Description
Cosinor (Cosine Vector) Circadian rhythm analysis method

introduced by Halberg et al (1967).
In Cosinor, twenty-four hours are plotted
on. Acrophase and Amplitude of Acrophase
are indicated on an r-axis.
95% confidence interval is used. If the
interval does not include the origin, the data
is interpreted that a statistically meaningful
rhythm exists. If the interval includes the origin,
the data is interpreted that the significance level
is 5% and the rhythm is rejected.

MESOR
(Midline Estimating Statistic of Rhythm)

Indicates the objectively-expressed mean
value of the circadian rhythm, with no bias
due to the considerations on the difference
of the day and night sampling numbers,
and the difference of the day and night
sampling intervals.
More accurate ABPM mean value when the
sampling intervals are not constant.

Amp. Amplitude Amplitude of a cosine curve best fitted to
the biological rhythm data.

Acrophase Phase that represents the maximum value
of a cosine curve best fitted to the biological
rhythm data. For example, an acrophase
indicates a time duration in which the
highest systolic blood pressure is obtained.
                                                     Continued
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Term/Abbreviation Description
c.i., Confidence Interval Interval surrounded by the confidence limit

of 95%.
95% confidence interval is expressed in
numerical data with the cosinor analysis
graph.

PR (Percent Rhythm) Rhythm compatibility
Squared multiple correlation coefficient (R)
between the measured value and the
cosine curve best fitted to the biological
rhythm data.
The closer to one a PR value is, the better
a regression line fits.
For example, when a PR value is greater
than 0.5, the cosinor analysis is considered
as valid.

Variation Index Variation index of rhythm [%].
Numerical value obtained as described
below.
Difference between the maximum value
and minimum value of the cosine curve
best fitted to the biological  rhythm data
divided by the maximum value.
When the maximum value is the blood
pressure obtained by day and the minimum
value is the blood pressure obtained at
night, the variation index can be useful to
judge clinical dipper and non-dipper
rhythms.
For example, the fall rate of the mean blood
pressure during sleep (at night) to the
mean blood pressure while awake (by day)
is indicated as below:

  0% to 10%: non-dipper
10% to 20%: dipper
20%  or over: extreme-dipper
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5-4 Terms Related to the Risk Management of High Blood Pressure
Term/Abbreviation Description
Hyperbalic Index, HBI High blood pressure index
Hypobalic Index Low blood pressure index
Hyperbalic Area Time integral of the blood pressure values

exceeding the limits.
24-hour blood pressure data is plotted on a
trend bar graph and an integral is
performed on the area exceeding the user-
defined limits.
Expressed as an index per day.
Usually, the risk is managed by comparing
the data with the HBI value of a healthy
person according to age and sex.

Hypobalic Area Time integral of the blood pressure values
not reaching the limits.
24-hour blood pressure data is plotted on a
trend bar graph and an integral is
performed on the area not reaching the
user-defined limits.
Expressed as an index per day.
Usually, the risk is managed by comparing
the data with the HBI value of a healthy
person according to age and sex.

HBI-sys The limits of the systolic blood pressure to HBI.
Set the limits of the blood pressures during
sleep (at night) and while awake (by day).

HBI-dia The limits of the diastolic blood pressure to HBI.
Set the limits of the blood pressures during
sleep (at night) and while awake (by day).
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